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1 Introduction to SimMechanics™ Software

Product Description
Model and simulate multibody mechanical systems

SimMechanics™ provides a multibody simulation environment for 3D
mechanical systems, such as robots, vehicle suspensions, construction
equipment, and aircraft landing gear. You model the multibody system using
blocks representing bodies, joints, constraints, and force elements, and then
SimMechanics formulates and solves the equations of motion for the complete
mechanical system. Models from CAD systems, including mass, inertia,
joint, constraint, and 3D geometry, can be imported into SimMechanics. An
automatically generated 3D animation lets you visualize the system dynamics.

You can parameterize your models using MATLAB® variables and
expressions, and design control systems for your multibody system in
Simulink®. You can add electrical, hydraulic, pneumatic, and other
components to your mechanical model using Simscape™ and test them all in
a single simulation environment. To deploy your models to other simulation
environments, including hardware-in-the-loop (HIL) systems, SimMechanics
supports C-code generation (with Simulink Coder™).

Key Features

• Blocks and modeling constructs for simulating and analyzing 3D
mechanical systems in Simulink

• Rigid body definition using standard geometry and custom extrusions
defined in MATLAB

• Automatic calculation of mass and inertia tensor

• Simulation modes for analyzing motion and calculating forces

• Visualization and animation of multibody system dynamics with 3D
geometry

• SimMechanics Link utility, providing an interface to Pro/ENGINEER®,
SolidWorks®, and Autodesk Inventor, and an API for interfacing with other
CAD platforms

• Support for C-code generation (with Simulink Coder)
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Required and Related Products

Required and Related Products

In this section...

“Required Products” on page 1-3

“Related Products” on page 1-4

Required Products
To use SimMechanics software, you must have installed current versions of
the following products:

• MATLAB

• Simulink

• Simscape

SimMechanics Visualization Requirements
SimMechanics visualization requires Silicon Graphics OpenGL® graphics
support on your system to display and animate SimMechanics models.

You can improve your speed and graphics resolution by adding a graphics
accelerator hardware card to your system. Animation of simulations
is sensitive to central processor and graphics card speed and memory.
Experiment with graphics hardware and system settings to find a reasonable
compromise between quality and speed for your system.

Support for Recorded Animations
You can record simulation animations in Microsoft Audio Video Interleave®

(AVI) format using SimMechanics visualization. Animations are recorded
as compressed AVI files with the default Motion JPEG codec. This codec is
available on most operating systems.

To play back AVI files, you need an AVI-compatible media application.
MATLAB has an internal movie player compatible with AVI. You can also use
an external AVI-compatible player.

1-3
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1 Introduction to SimMechanics™ Software

Note SimMechanics visualization does not support uncompressed AVI
recording.

Related Products
You can extend the capability of SimMechanics using other physical modeling
products found in the Simscape family. Each physical modeling product gives
you a set of block libraries with which you can model common components
found in industry and academia: rigid bodies, gears, valves, solenoids, etc.

With the physical modeling products, you can model not only mechanical
systems, but also electrical, hydraulic, and power systems. You can model
each system separately, and then integrate the systems into a single
multiphysics model where you can analyze combined system performance.

Physical Modeling Product Family
The physical modeling family includes five products:

• SimDriveline™, for modeling and simulating drivetrain systems

• SimElectronics®, for modeling and simulating electronic systems

• SimHydraulics®, for modeling and simulating hydraulic systems

• SimMechanics, for modeling and simulating three-dimensional mechanical
systems

• SimPowerSystems™, for modeling and simulating electrical power systems
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Representing Machines with SimMechanics™ Blocks

Representing Machines with SimMechanics Blocks
To model a 3-D multibody system, you use the SimMechanics block library.
This library contains seven sublibraries that you represent the different
model components with. Components that you can represent include rigid
bodies, joints, gear and general kinematic constraints, forces and torques,
and motion sensors.

Open the Library
To open the SimMechanics block library, at the MATLAB command line enter
sm_lib. The SimMechanics block library opens in a new window. The figure
shows the library that opens.

SimMechanics™ Product Library

Explore the Library
The table provides an overview of the SimMechanics sublibraries. Open each
sublibrary to explore its blocks. For detailed information about a block, see
its reference page. You can do this by double-clicking the block, then clicking
Help in the block dialog box.

Sublibrary Description

Body Elements Represent the solid properties of a
rigid body

Constraints Constrain the relative motion
between two rigid body frames
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Sublibrary Description

Forces and Torques Apply internal and external forces
and torques on or between rigid body
frames

Gears, Couplings and Drives Couple the motion of two rigid body
frames

Joints Represent the mechanical degrees
of freedom between two rigid body
frames

Utilities Represent the external environment
of a multibody system

Related
Examples

• “Start New Multibody Model” on page 1-7
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Start New Multibody Model

Start New Multibody Model
You can start a new multibody model from the MATLAB command line. To do
this, enter smnew. A new model window opens with commonly used blocks.
The SimMechanics block library also opens. The figure shows the new model
window that you see. Drag blocks from the library into the model window to
begin modeling a new multibody system.

Concepts • “Representing Machines with SimMechanics Blocks” on page 1-5
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Multibody Model Anatomy

In this section...

“Basic Model Components” on page 1-8

“Applying Forces and Torques” on page 1-11

“Sensing Motion” on page 1-13

“See Also” on page 1-15

With SimMechanics, you represent a multibody system using blocks. Like all
physical modeling products, each block represents a physical component or
an abstract entity fundamental to physical modeling—e.g. frames and frame
transforms. By connecting the blocks with connection lines, you define the
relationships that connect the physical components. In a basic model, these
physical components include rigid bodies and joints. In more advanced models,
you can find forces and torques, motion sensors, and kinematic constraints.

Basic Model Components
The figure shows the block diagram of a multibody system—the four-bar
linkage. This model contains subsystem blocks to represent the links and
pivot mounts. These represent the rigid bodies of the model. The model
contains also four Revolute Joint blocks. These represent the joints in the
model. Combined, these blocks form the foundation of this model.
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Multibody Model Anatomy

While important, rigid body subsystem and joint blocks are not sufficient
to represent the four-bar linkage. Other blocks serve important purposes.
These include World Frame, Rigid Transform, Mechanism Configuration,
and Solver Configuration blocks. The table summarizes their purpose in a
multibody model.

Block Purpose

World Frame Provides the ultimate reference
frame in a model. All remaining
frames are defined with respect
to this frame. It is inertial and it
defines absolute rest.

Rigid Transform Apply a fixed spatial relationship
between frames. This block defines
the offset distance and angle between
two frames.
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Block Purpose

Mechanism Configuration Identifies the gravity vector in a
model.

Solver Configuration Provides essential simulation
parameters required to simulate the
model.

The figure breaks the four-bar model into its logical components. These are
the physical components and abstract entities that you need in order to
represent this system.

Each rigid body subsystem contains SimMechanics blocks that represent
solids and their spatial relationships˙. The blocks are Solid and Rigid
Transform. The figure shows the blocks that model one of the binary links.
Three Solid blocks represent the three solid sections of this rigid body—main,
peg, and hole sections. Two Rigid Transform blocks represent the fixed spatial
relationships between the three solids. You use them to position the peg and
hole sections at the ends of the main section.
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Applying Forces and Torques
You can actuate a model by applying a force or torque to a rigid body or to a
joint. To represent forces and torques acting on a rigid body, SimMechanics
provides a Forces and Torques library. Drag a block from this library and
connect it to the rigid body frame(s) that you want to apply the force or torque
to.

One block represents an external force or torque—External Force and Torque.
The other blocks represent internal forces between two rigid body frames.
You can represent a general internal force, using the Internal Force block,
or a specific internal force type, using Spring and Damper Force and Inverse
Square Law Force blocks. The figure shows how you can use the External
Force block to actuate the crank link of the four-bar model.
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To represent forces and torques acting at a joint, SimMechanics provides a
selection of actuation inputs in each Joint block. Each joint primitive—the
basic component of a joint block—provides a selection of actuation inputs that
you can select. You can represent a torque acting on a revolute or spherical
joint primitive, or a force acting on a prismatic joint primitive. The figure
shows how you can use the base-crank revolute joint block to actuate the
joint directly.
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Sensing Motion
You can sense motion between two arbitrary rigid body frames. For this task,
SimMechanics provides the Transform Sensor block, which you find in the
Frames and Transforms library. This block provides the broadest motion
sensing capability in SimMechanics. With it, you can sense position, velocity,
and acceleration, both rotational and translational, between any two frames
in a model. The figure shows how you can use the Transform Sensor block
to sense the position coordinates of the coupler link reference frame with
respect to the World frame.
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To sense motion directly between two rigid body frames connected at a joint,
SimMechanics provides a selection of sensing outputs in each joint block.
Each joint primitive provides a selection of sensing outputs that you can
select. You can sense rotational position, velocity, and acceleration using
revolute and spherical joint primitives. You can also sense translational
position, velocity, and acceleration using prismatic joint primitives. The
figure shows how you can sense the angular position of the coupler-rocker
revolute joint directly from the joint block.
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See Also
For more information, see:

• “Model Aiming Mechanism” on page 1-30
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Multibody Modeling Workflow

In this section...

“Model Rigid Bodies” on page 1-16

“Assemble Multibody Model” on page 1-20

“Add Forces, Torques, and Motion Sensors” on page 1-23

“Simulate and Analyze model” on page 1-27

The multibody modeling process contains a set of well-defined, sequential
steps. Before you begin, define the intent of the model. Then, select a
modeling approach and define the model requirements.

SimMechanics supports two modeling approaches:

• Manually build model — most common modeling approach. The following
sections outline the manual approach.

• Automatically generate model from CAD assembly — for users wishing to
simulate a CAD assembly in a physical modeling environment. Approach
requires access to supported CAD software and assembly files. See “CAD
Translation”.

Model Rigid Bodies
Rigid bodies are the building blocks of a multibody system. Before you can
connect rigid bodies with joints and constraints, you must model the rigid
bodies. You can create two types of rigid bodies:

• Simple — Use a single Solid block to model the rigid body. Simple rigid
bodies are quicker to model. Use simple rigid bodies to quickly produce
proof-of-concept models, before you create more detailed rigid body
subsystems.

A simple cylinder is a simple rigid body.
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Multibody Modeling Workflow

• Compound — Rigidly connect multiple Solid blocks to model the rigid body.
Compound rigid bodies require more time to model, but provide the most
accurate representation of a rigid body that you can manually build.

A detailed binary link is a compound rigid body.
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A complete rigid body subsystem contains the following:

• Frames — Construct with position and orientation in space.

• Physical properties — Geometry, inertia, and graphic parameters of a solid.

Add Frames
To add frames to a rigid body subsystem, you use the Rigid Transform block.
The block rotates and/or translates a base frame to obtain a follower frame. A
chain of Rigid Transform blocks represents a chain of frames. Connect the
reference frame port of a Solid block to a frame port or line to give the frame a
position and orientation in space. See “Representing Frames”.

The binary link subsystem contains three Solid blocks rigidly connected
with two Rigid Transform blocks. Each Rigid Transform block translates a
local reference frame, located at the center of the link, by an amount equal
to half the link length along the length axis. The two end frames serve as
joint connection frames.

1-18



Multibody Modeling Workflow

Add Geometry, Inertia, and Graphic Properties
To add geometry, inertia, and graphic properties to a rigid body, you use the
Solid block. In the dialog box of the block, you can specify the numerical
values for each parameter set:

• Geometry — 3-D shape of the rigid body. Required for assembly,
vizualization and simulation.

• Inertia — Mass or density and inertia tensor. Required for simulation.

• Graphic — Color of the rigid body. Required for visualization.

In the binary link subsystem, three Solid blocks provide the physical
properties of three elementary pieces:

• Peg — Cylinder shape

• Main body — General Extrusion shape

• Hole Section — general Extrusion shape
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In the Inertia menu of the Solid dialog box, you can specify the density if the
link material — e.g. 2.70 g/cm^3 for Aluminum. SimMechanics provides the
option to automatically calculate the moments and products of inertia from
geometry. To provide a uniform density to the binary link, the three Solid
block contain the same value in the Density field.

In the Graphic menu of the Solid dialog box, you can specify the color of the
link material. In this example, the color is orange with RGB vector [0.8
0.45 0]. To provide a single color to the binary link, the three Solid blocks
contain the same RGB vector in the Colorparameter.

Assemble Multibody Model
Once you have created the rigid body subsystems, you can assemble the
subsystems into a mechanism or machine. In a mechanism or machine, joints
and constraints provide well-defined degrees of freedom that constrain rigid
body motion. Two types of motion are possible:
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• Rotation about one or more axes

• Translation along one or more axes

Connect Joints
To assemble rigid body subsystems into complete multibody systems, connect
the with joints. SimMechanics provides a library with fourteen joint blocks.
Each block provides a different number and/or type of mechanical degrees of
freedom. Exactly two rigid body frames connect to each joint, with each frame
belonging to a different rigid body.

Joints are composed of joint primitives — elementary joints that you can
combine to create more complex joints. SimMechanics contains three joint
primitives:

• Prismatic — one translational degree of freedom along an axis

• Revolute — one rotational degree of freedom about an axis

• Spherical — three concurrent degrees of freedom about three axes

The following table identifies the joint primitives associated with each joint.

Prismatic Primitives

0 1 2 3

0 Weld Joint Prismatic
Joint

Rectangular
Joint

Cartesian
Joint

1 Revolute
Joint

Cylindrical
Joint

Planar
Joint

—

2 Universal
Joint

— — —

Revolute
Primitives

3 Gimbal
Joint

Bearing
Joint

— 6–DOF
Joint

Spherical
Primitives

1 Spherical
Joint

Telescoping
Joint

— Bushing
Joint

The four-bar system contains four rigid bodies connected with four revolute
joints. The block diagram for this model contains four rigid body subsystems
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connected with four Revolute Joint blocks. The following figures show the
Mechanics Explorer display of a four-bar model and the associated block
diagram.
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Specify Joint State Targets
To specify the initial configuration of a multibody assembly, use the State
Targets menu of the joint dialog box. You can specify values for the initial
joint position and velocity, and assign different priorities for the state targets.
SimMechanics attempts to meet the state target. If the state targets make
assembly impossible, SimMechanics tries to use an approximate value that
allows assembly.

Add Forces, Torques, and Motion Sensors
You can add force and torques to, or between, rigid body frames. The following
table summarizes the force/torque types that you can add to a model. The
Procedure column identifies the steps required to add each force/torque
type to a model.
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Force/Torque Type Description Procedure

Joint actuation Force or torque between
base and follower
frames along or about
joint primitive axis

1 In the Actuation
menu of the joint
dialog box, select the
desired actuation
mode.

2 Connect a physical
signal line to each
exposed physical
signal port.

Joint internal
mechanics

Spring and damper
force or torque between
base and follower
frames along or about
joint primitive axis

1 In the Internal
Mechanics menu
of joint dialog box,
enter the spring and
damper parameters
for the joint.

Rigid body actuation Force or torque acting
on a rigid body frame
not connected to a joint

1 Connect an External
Force and Torque
block to the rigid
body frame you wish
to actuate.

2 In the dialog box
of the block, select
the force and torque
components you wish
to specify and the
frame in which you
wish to resolve the
components.

3 Connect a physical
signal line to each
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Force/Torque Type Description Procedure

exposed physical
signal port.

Rigid Body Internal
Forces

Force acting between
two rigid body frames,
one frame per rigid
body

1 Connect the Inverse
Square Law Force or
Spring and Damper
Force block between
the two rigid body
frames.

2 In the dialog box of
the block, enter the
force constants.

You can also add mechanical sensing between frames. Force sensing is
limited Inverse Square Law Force or Spring and Damper Force blocks. The
following table summarizes the types of motion and force sensing you can
add to a model. The Procedure column identifies the steps required to add
each sensing type to a model.

Sensing Description Procedure

Joint Motion Sensing of position,
velocity, and
acceleration
parameters of joint
follower frame with
respect to base frame

1 In the Sensing
menu of the joint
dialog box, select
the desired motion
parameter.

2 Connect a physical
signal to each
exposed physical
signal port.

Rigid Body Motion Sensing of position,
velocity, and
acceleration
parameters of one
rigid body frame with

1 Connect the
Transform Sensor
block to two rigid
body frames.
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Sensing Description Procedure

respect to any other
frame in a model 2 In the dialog box

of the Transform
Sensor block,
select the motion
parameters you wish
to sense.

3 Connect a physical
signal to each
exposed physical
signal port.

Force Input Sensing of force
magnitude in Inverse
Square Law Force and
Spring and Damper
Force blocks

1 In the dialog box of
the force block, select
Sense Force.

2 Connect physical
signal to the exposed
fm physical signal
port.

The following figure shows an application of joint actuation inputs. The
Base-Crank joint of a four-bar model receives a torque input indirectly from
the Simulink block Signal Builder. The Simulink-PS Converter block converts
the Simulink signal into a physical signal compatible with SimMechanics
blocks.
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Simulate and Analyze model
Run the simulation to examine the dynamic behavior of the model. Simulink
provides a set of model simulation options that you can adjust for your
application. Before running simulation:

• Check the choice of solver. SimMechanics models require a continuous
solver. Variable-step solvers provide the best performance. Use ode45
(Dormand-Prince) as a first try for most models.

• Check the solver step sizes and tolerances. Smaller values for both
parameters produce more accurate results at the cost of increased
simulation time.

• Check the simulation time span. To let a simulation run indefinitely,
specify inf in the Stop time field.
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The Mechanics Explorer utility provides 3-D visualization for SimMechanics
models. By default, the utility opens the first time you update a model, and
refreshes for all subsequent model updates. The following figure shows the
Mechanics Explorer display of a double-pendulum model.
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During simulation, you can open any scope blocks in the model to examine
the dynamic behavior of the model. The following figure shows the angular
position and velocity of the bottom frame of a damped double-pendulum
model as functions of time.
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Model Aiming Mechanism

In this section...

“Open Model” on page 1-31

“Explore Model” on page 1-31

“Update Model” on page 1-34

“Troubleshoot Assembly Error” on page 1-34

“Simulate Model” on page 1-37

“See Also” on page 1-39

This example provides an overview of the modeling process for a
double-crank aiming mechanism. The basis of this example is the
sm_dcrankaim_assembly_with_error model present in your SimMechanics
installation. The model contains an intentional assembly error, which you
troubleshoot using the Model Report tool of Mechanics Explorer.
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Open Model
To open the model, at the MATLAB command line, enter
sm_dcrankaim_assembly_with_error. The model opens in a new window.

Explore Model
The figure shows a schematic of the system that the model represents. This
system contains four rigid bodies, labeled A-D. These rigid bodies connect in a
closed loop via four joints, labeled Ri, Ro, Rg, and Pg. When connected to each
other, these components form a system with one degree of freedom.
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The model represents the components of this system using blocks. Each block
represents a physical component. A World Frame block provides the ultimate
reference frame in the model. The figure shows the block diagram that the
model uses to represent the double-crank aiming mechanism.
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To represent the rigid bodies, the model contains four subsystem blocks,
labeled Rigid Body A-D. Each subsystem contains one Solid block and
multiple Rigid Transform blocks. The Solid block provides geometry, inertia,
and color to the rigid body subsystem. The Rigid Transform blocks provide
the frames that you connect the joints to. A Reference Frame block identifies
the ultimate reference frame in the subsystem block.

The model labels the rigid body subsystem blocks Rigid Body A-D. To examine
the block diagram for a rigid body subsystem, right-click the subsystem block
and select Mask > Look Under Mask. The figure shows the block diagram
for Rigid Body A.
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To represent the joints, the model contains four joint blocks. Three joints
provide one rotational degree of freedom between a pair of rigid bodies. You
represent each of these joints with a Revolute Joint block. A fourth joint
provides one translational degree of freedom between a pair of rigid bodies.
You represent this joint with a Prismatic Joint block. The model labels the
revolute joint blocks Ro, Rg, and Ri, and the prismatic joint block Pg.

Update Model
As the model name suggests, this model contains an error. The error prevents
the model from assembling successfully, which causes simulation to fail. To
update the model and investigate the assembly error:

• On the Simulink menu bar, select Simulation > Update Diagram.

Mechanics Explorer opens with a static display of your model in its initial
state. Because the model contains an assembly error, SimMechanics issues
an error message. Ignore that message for now.

Troubleshoot Assembly Error
The Mechanics Explorer utility contains a Model Report tool which identifies
the status of joints and constraints. Use the Model Report utility to determine
if joints and constraints have successfully assembled. The report also provides
information on the configuration of joints and constraints. To see the report:
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• On the Mechanics Explorer menu bar, select Tools > Model Report.

The model report opens in a new window. The top section of this window
identifies the assembly status of the model as a whole. Because assembly
failed, the assembly status for this model is “Unassembled”. Because the
source of the assembly error is a joint block, the assembly status for joints is
“Unable to assembly all joints”.

To identify the joint block that caused assembly fail, examine the model
report Joints tab. A red square identifies the problematic joint—Pg. This
joint did not assemble, and the model report provides neither position nor
velocity information for that joint.

Identifying Error Root Cause
The error message that SimMechanics issued during model update identifies
position violation as the root cause of assembly failure. This suggests that
the frames which joint Pg connects to are improperly aligned. To confirm this
hypothesis, check the orientation of these frames in Mechanics Explorer.

1 In the Mechanics Explorer tree view pane, click joint Pg.
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2 In the Mechanics Explorer visualization pane, examine the position and
orientation of the highlighted frames. These are the frames that appear in
turquoise blue.

The two frames are offset along the Z axis. Because joint Pg provides a
translational degree of freedom along the Z axis, this offset is valid. However,
the follower frame has a different orientation than the base frame. It contains
a rotation angle of 90 degrees about the common Z axis with respect to the
base frame. Because joint Pg provides no rotational degrees of freedom, this
rotation angle is invalid. This angle prevents the two joint frames from
aligning correctly, causing assembly to fail.
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Correcting Assembly Error
To correct the assembly error, you must change the orientation of either base
or follower joint frames. In this example, you change the orientation of the
follower frame so that the model can assemble successfully. To change the
orientation of this frame:

1 Right-click the Rigid Body C subsystem block and select Mask > Look
Under Mask.

2 Double-click the Slide Frame Transform block and select the new
parameter values that the table provides.

Parameter New Value

Rotation > Pair 2 > Follower +X

Rotation > Pair 2 > Base +Y

3 Click OK.

Simulate Model
You can now simulate the model. On the Simulink menu bar, select
Simulation > Run. Mechanics Explorer opens with a dynamic display of
your model. The figure shows this display. Rotate, pan, and zoom to explore.
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You can use the Model Report tool to verify the assembly status. To do this,
on the Mechanics Explorer menu bar, select Tools > Model Report. The
model report opens in a new window. Check that the assembly status icon
for the model and its joints is a green square. The green square indicates
that assembly has been successful.
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See Also
For more information, see:

• “Identifying Assembly Issues”

• “Model Double Pendulum”

• “Model Four-Bar Linkage”
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Modeling with SimMechanics First and Second Generations
SimMechanics software contains two technologies: First Generation and
Second Generation. First-generation technology includes the block library
and visualization utility found in SimMechanics releases prior to R2012a.
Second-generation technology introduces a simpler modeling paradigm
with a new block library, a powerful computational engine, an advanced
visualization utility based on OpenGL computer graphics, and tighter
integration with Simscape products.

SimMechanics first- and second-generation technologies have different sets
of capabilities. Which technology to use depends on the effects you need to
model. Use first-generation technology for models requiring variable gravity,
certain complex constraints, motion actuation, or to measure reaction or
constraint forces. In nearly all other cases, use second-generation technology.

The table provides a detailed comparison between first- and second-generation
technologies.

Feature SimMechanics First
Generation

SimMechanics
Second-Generation

Mass/Inertia
Calculation

Manual only Automatic or manual

Solid Geometry No Yes

Animation Replay No Yes

3–D Model Exploration Limited Yes

Initial State Targets Limited Yes

Simscape Logging No Yes

Code Generation Yes Yes

CAD Import Yes Yes2

Motion Actuation Yes No

Force Sensing Yes No

Complex Constraints1 Yes Gears only

Variable Mass/Gravity Yes No
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1Point-curve, Gear, Velocity, and Screw constraints

2CAD update supported only in first-generation

SimMechanics continues to support first-generation technology. You can
maintain and simulate legacy models built with first-generation blocks.
You can also create a new first-generation model using the SimMechanics
First Generation block library. For more on modeling with first-generation
technology, see “What You Can Do with SimMechanics Software”
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